
Начиная с версии Summer 08, в

программе Altium Designer осущест�

вляется взаимодействие с данными

MCAD�систем на высоком уровне. Это

позволяет импортировать, редакти�

ровать и проверять сопряжённость с

механическими деталями в проекте

платы. Файлы данных MCAD могут

иметь связь с реальными файлами

для обновления информации о дета�

лях в Altium Designer.

Ранее установка механических де�

талей в проекты печатных плат сред�

ствами «электронных» САПР (ECAD)

и их последующий импорт в MCAD

являлись сложным, многоэтапным

процессом. В пакете Altium Designer
имеется целая группа команд, позво�

ляющая добавлять детали на плату и

размещать их согласно техническим

требованиям. Это даёт возможность

не только установить на плату такие

детали, как радиаторы, втулки, под�

ставки и т.д., но также закрепить пла�

ту в корпусе и добавить другую плату

с компонентами.

В качестве формата взаимодей�

ствия MCAD и Altium Designer исполь�

зуется формат STEP, являющийся

стандартом обмена механическими

моделями. Деталь с геометрией лю�

бой сложности в формате STEP может

быть сформирована в любой из про�

грамм твердотельного моделирова�

ния (SolidWorks, ProE, Компас и т.д.).

Формат STEP применяется большин�

ством разработчиков электронных

компонентов, которые предоставля�

ют в нём модели корпусов полупро�

водниковых приборов. Пакет Altium

Designer поддерживает оба формата

STEP (AP203 и AP214), однако следует

помнить, что в формате STEP AP203

не сохраняется информация о цвете

модели.

Пакет Altium Designer позволяет

вести работу с моделями в формате

STEP двумя способами. Во�первых,

можно просто добавить деталь на

плату; во�вторых, можно создать

ссылку на файл модели. Ссылка на

файл предполагает наличие «горя�

чей» связи между приложением и ис�

ходным файлом модели. При созда�

нии такой ссылки и последующим

изменением исходной модели STEP в

основной программе, Altium Designer
автоматически определяет измене�

ния и предлагает внести их в модель

на плате. Для использования ссылок

на файлы моделей должны быть ука�

заны некоторые папки, которые

Altium Designer будет постоянно про�

верять на наличие обновлений. Рас�

смотрим инструментарий для рабо�

ты с механическими деталями в ре�

дакторе плат Altium Designer на

конкретных примерах.

Создадим ссылки на две готовые

модели STEP, составляющие сборку

корпуса устройства, в котором будет

использоваться плата. Сопоставив де�

тали корпуса с платой, выполним

проверку сопряжённости деталей и

отредактируем размещение компо�

нентов с учётом механических час�

тей. В примере будет использован

проект multivibrator_step.pcbdoc, ко�

торый находится в папке Altium
Dsigner/Examples/Tutorials/multivibra�
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tor_step; там же находятся необходи�

мые для работы модели в формате

STEP.

Перед использованием моделей в

формате STEP необходимо указать

ссылку на папку, в которой хранятся

необходимые модели. Для этого вы�

полним следующие действия:

● откроем окно настроек DXP > Prefe�
rences > PCB Editor > Models;

● нажмём кнопку в области Model
Search Path, укажем папку, содержа�

щую модели (Altium Dsigner/Examp�
les/Tutorials/multivibrator_step), и

нажмём ОК. Если папка с моделями

находится в папке текущего проек�

та, то достаточно указать относи�

тельное расположение;

● после выбора папки с моделями

нажмём кнопку Add, и папка доба�

вится в текущий список;

● нажмём кнопку ОК в диалоговом

окне Preferences.

После указания местонахождения

моделей можно приступить к разме�

щению моделей STEP или ссылок на

них в документе платы. Для дальней�

шей работы откроем документ платы,

к которой будут добавлены детали

корпуса:

● откроем плату multivibrator_step.pcb�
doc (File > Open), расположенную в

папке Altium Dsigner/Examples/Tuto�
rials/multivibrator_step;

● выполним команду Place > 3D Body,

при этом откроется диалог 3D Body.

Для создания ссылки на 3D�модель,

необходимо выбрать Generic STEP
Model в области 3D Model Type и на�

жать кнопку Link to Step Model. Появ�

ляется окно, в котором представлен

список всех моделей, находящихся

в подключенных папках. Примеча�
ние: 3D�модели можно размещать

как в двумерном, так и в трёхмер�

ном режиме (переключение режи�

мов осуществляется клавишами 2

(2D) и 3 (3D);

● выберем файл multivibrator_base.step
и нажмём ОК в обоих окнах. Модель

«привязывается» к курсору; для её
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размещения необходимо нажать

ЛКМ в любом месте рабочей облас�

ти. Теперь на плате имеется обнов�

ляемая модель со ссылкой на ис�

ходный файл;

● после размещения первой модели

на экране снова появляется диалог

3D Body, где предлагается устано�

вить следующую модель. Нажмём

кнопку Link to Step Model, в списке

выберем модель multivibrator_co�
ver.step и разместим её аналогич�

ным образом;

● после размещения обеих моделей

нажимаем кнопку Cancel в диалоге

3D Body для выхода из режима раз�

мещения.

Если размещение происходило в

обычном (двумерном) режиме, то

на экране показаны прямоугольни�

ки, нарисованные на слое Mechani�
cal1. Чтобы просмотреть результат

размещения деталей, переключим�

ся в трёхмерный режим нажатием

клавиши 3. Если на экране не отоб�

ражаются трёхмерные детали, зна�

чит, их просмотр отключен. Для

включения отображения STEP�де�

талей и других трёхмерных объек�

тов необходимо (находясь в режи�

ме 3D!) включить оба параметра в

разделе 3D Bodies (см. рис. 1) в

настройках Design > Board Layers
and Colors (клавиша L).

В результате на экране, кроме

платы, будут показаны две модели

деталей корпуса. Теперь необходи�

мо разместить эти детали относи�

тельно платы так, как они будут

выглядеть в сборке. Для выравнива�

ния импортированных деталей в

пакете Altium Designer используют�

ся грани модели или контрольные

точки (заданные пользователем).

Кроме этого, имеется возможность

вращать модель в любой плоскости

и указывать высоту расположения

детали относительно платы. В рас�

сматриваемом примере модели

расположены в рабочей области

случайным образом и далеко раз�

несены относительно платы, поэто�

му необходимо выполнить вырав�

нивание. С этой целью могут быть

использованы следующие опера�

ции:

● установка вертикального положе�

ния модели относительно плоскос�

ти платы;

● использование одиночной конт�

рольной точки для перемещения

всей модели;

● использование трёх контрольных

точек для перемещения, выравни�

вания и вращения модели;

● использование поверхности платы

для выравнивания модели относи�

тельно платы;

● использование элементов управле�

ния моделью через диалоговое ок�

но свойств 3D�модели.

В рассматриваемом примере будут

продемонстрированы все перечис�

ленные методы позиционирования

модели относительно платы.

В тех случаях, когда модель детали

имеет такую же ориентацию, как пла�

та (т.е. совпадают направления базо�

вых осей модели и платы), для пози�

ционирования может быть исполь�

зована одна точка на модели. В

рассматриваемом примере модель

имеет ту же ориентацию, что и плата.

Если посмотреть на плату и базовые

детали корпуса, можно заметить на

корпусе прямоугольный выступ, кото�

рый должен проникать сквозь плату.

Однако на плате пока отсутствует паз

для этого прямоугольного выступа –

его место необходимо определить.

Можно измерить в MCAD положе�

ние выступа и по нему определить

положение паза в плате. Перед этим

следует измерить внутренний размер

корпуса, чтобы определить, помес�

тится ли в него плата:

● переключаемся в 3D�режим нажа�

тием клавиши 3;

● выполняем команду Tools  > 3D Body
Placement  > Measure Distances;

● нажатием ЛКМ выделяем нижнюю

часть корпуса, после чего курсор

принимает вид трёхмерного голубо�

го прицела, который перемещается

по привязкам на вершинах модели;

● чтобы измерить размер внутрен�

ней части корпуса, необходимо

выбрать две точки, как показано

на рисунке 2, и затем измерить

ширину и длину. Примечание: из�

за базовой дюймовой системы

координат размеры могут быть

отображены с погрешностью

0,00001 мм;

● аналогично можно измерить диа�

гональ внутренней части, при этом

будут показаны и внутренние раз�

меры; после завершения измере�

ния следует нажать ПКМ.

Теперь, чтобы определить, помес�

тится ли плата в данный корпус, из�

мерим параметры самой платы, в

том числе её линейные размеры,

для чего выполним Reports > Board
Information.

Следующим шагом необходимо

определить базовую точку в центре

прямоугольного выступа в корпусе

для его сопряжения с платой. Распо�

ложение паза требует наличия отве�

рстия в плате и некоторой зоны зап�

рета вокруг этого отверстия:

● выполним команду Tools > 3D Body
Placement > Add Snap Points from
Vertices (в терминологии Altium
Designer Vertices – это точки привяз�

ки на вершинах детали, Snap Points –

точки привязки, заданные пользо�

вателем);

● выберем нажатием ЛКМ нижнюю

деталь корпуса, после чего к ней бу�

дет привязан курсор прицела;
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Рис. 1. Включение отображения 3D�моделей

Рис. 2. Измерение внутренних размеров базовой части корпуса



● переместим курсор по модели и вы�

берем точки привязки на каждом

из углов двух прямоугольных вы�

ступов (т.е. создадим пользователь�

ские привязки). Красными стрелка�

ми на рисунке 3 показаны вершины

большого паза, а синими стрелка�

ми – вершины малого паза. После

выбора точек нажмём ПКМ или Esc

для завершения;

● кроме уже выбранных точек, для

работы понадобится ещё одна –

центр паза. Для установки этой точ�

ки снова вызовем режим установки

точек и выберем деталь;

● далее клавишей Space выберем ре�

жим Mid�point, который создаёт

точку привязки между двумя ука�

занными точками. Выберем две

точки по диагонали паза и клави�

шей Esc завершим операцию.

На следующем этапе поместим точ�

ку привязки в центре платы в виде

контактной площадки:

● переключимся в двумерный режим

и проверим, что начало координат

находится в левом нижнем углу

платы. Если это не так, отредакти�

руем положение этой точки коман�

дой Edit > Origin;

● выполним команду Place > Pad;

● выполним команду Edit > Jump >
New Location, которая позволит пе�

рейти в заданные координаты;

● в появившемся окне введём обе ко�

ординаты 25,4 и два раза нажмём

клавишу Enter. В результате в цент�

ре платы будет размещено метал�

лизированное отверстие.

Теперь можно позиционировать

нижнюю деталь корпуса относитель�

но платы, используя одну точку при�

вязки. Для этого не обязательно нали�

чие пользовательских точек привяз�

ки; здесь могут быть автоматические

точки привязки, которые формиру�

ются на вершинах модели:

● перейдём в трёхмерный режим

(клавиша 3);

● выполним команду Tools > 3D Body
Placement > Position 3D Body;

● нажатием ЛКМ выберем модель

нижней детали корпуса, после чего

на ней появится курсор прицела;

● нажмём клавишу Tab для выбора ре�

жима точек. Здесь можно использо�

вать для сопоставления точки при�

вязки (Vertices) и пользовательские

точки привязки (Snap Point). В дан�

ном случае следует выключить па�

раметр Include Vertices;

● переместим курсор в центр модели,

и ЛКМ зафиксируем эту точку;

● переместим курсор в центр платы

и ЛКМ зафиксируем положение,

когда курсор совпадёт с центром

контактной площадки. В результате

деталь корпуса будет совмещена с

платой.

Примечание: При выборе центра

платы курсор должен принять зелё�

ный цвет. Это означает, что его поло�

жение попадает в электрическую сет�

ку вокруг контактной площадки.

При описанном позиционирова�

нии платы она получается подвешен�

ной над корпусом, поэтому необхо�

димо совместить плоскость нижнего

слоя платы с верхней гранью широ�

кого паза. Для этого, находясь в трёх�

мерном режиме, двойным щелчком

ЛКМ заходим в свойства модели ниж�

ней детали корпуса и в списке Body
Side выбираем Bottom Side. При этом

корпус расположен обратной сторо�

ной к плате. Чтобы повернуть его в

нормальное положение, следует зай�

ти в свойства модели и в строке

Rotation X указать 180 градусов.

Совместим плоскость платы с

гранью паза, для чего выполним сле�

дующие действия:

● Tools > 3D Body Placement > Set Body
Height;

● ЛКМ выберем модель нижней дета�

ли платы, после чего появится кур�

сор прицела;

● переместим курсор на один из уг�

лов широкого паза, чтобы задать

грань для выравнивания;

● в появившемся окне предлагается

задать расстояние, на которое бу�

дет отодвинута плата от выбранной

грани паза. В нашем случае выбе�

рем вариант Board Surface – тогда

выравнивание будет происходить

по плоскости платы.

Итак, позиционирование нижней

детали корпуса завершено, и в целом

оно было несложным, поскольку ори�

ентация детали совпадала с ориента�

цией платы. Теперь разместим вто�

рую деталь, ориентация которой не

совпадает с платой.

Сначала выполним выравнивание

детали по плоскости платы:

● Tools > 3D Body Placement > Align
Face with Board;

● выберем нижнюю деталь корпуса

нажатием ЛКМ;

● курсор мыши «привязывается» к

детали; при перемещении разные

грани ставшей прозрачной дета�

ли подсвечиваются. Необходимо

выбрать ту грань, которая будет

выровнена с плоскостью платы

(см. рис. 4).

Результатом описанного действия

будет совпадение плоскости платы и

нижней грани детали. При этом на�

правления детали и платы могут не

совпадать, поэтому совместим деталь

с платой, используя три точки (в от�

личие от предыдущей детали, кото�

рая сопоставлялась по одной точке).

Для этого выбираем три точки на

плоскости детали и затем три точки

на плоскости платы, направление ко�

торых должно совпадать:

● Tools > 3D Body Placement > Orient
and Position 3D Body;
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Рис. 3. Установка базовых точек

Рис. 4. Выравнивание детали по плоскости

платы



● выберем нижнюю деталь корпуса

нажатием ЛКМ, после чего курсор

примет вид прицела в виде большо�

го перекрестия голубого цвета, и

укажем три точки на детали;

● курсором синего цвета укажем уг�

лы платы, соответствующие на�

правлению ранее выбранных то�

чек детали (при наведении на

угол платы прицел становится зе�

лёным, что говорит о попадании

в зону вершины платы; если этого

не происходит, рекомендуется

увеличить шаг сетки Electrical
Grid);

● после выбора трёх вершин платы

происходит сопоставление на�

правления выбранных точек, что

обеспечивает необходимое поло�

жение детали.

После размещения всех деталей

видно, что разъём Y1 не попадает в

расположение окна, и необходимо

либо поменять расположение окна в

детали, либо переместить разъём на

плате. В данном случае необходимо

переместить разъём непосредствен�

но в режиме 3D, захватив его ЛКМ.

Однако более точно позициониро�

вать разъём можно в 2D�режиме, но

для этого необходимо в режиме 3D

установить пользовательские точки

привязки, которые будут отображать�

ся в режиме 2D (см. рис. 5)

Для управления отображением де�

талей в трёхмерном режиме удобно

воспользоваться панелью PCB, кото�

рая является аналогом панели Design
Manager в P�CAD, но, в отличие от

последней, позволяет вести работу

не только с цепями и компонентами,

но и с остальными объектами, при�

сутствующими на плате. После за�

пуска панели PCB выбираем работу с

3D�моделями (см. 1 на рис. 6). Теперь

в панели перечислены все модели,

которые добавлены на плате (см. 3

на рис. 6), и здесь же можно управ�

лять прозрачностью той или иной

модели.

К моделям можно применить стан�

дартные команды: выделение, маски�

ровку и масштабирование (см. 2 на

рис. 6). Ниже дублируются парамет�

ры отображения моделей на плате

(см. 4 на рис. 6 и рис. 1). Если в пане�

ли PCB выполнить двойной щелчок

ЛКМ на названии модели, то откроет�

ся окно свойств этой модели, где

можно управлять базовыми парамет�

рами расположения модели в прост�

ранстве относительно платы (пово�

роты по трём направлениям и высота

над платой).

Команды управления изображени�

ем в режиме 3D были рассмотрены в

одной из предыдущих статей(СЭ № 8,

2008). Помимо команд, связанных с

ПКМ и кнопкой Shift, используются

ещё несколько команд. Так, напри�

мер, нажатие клавиши 0 выравнивает

плату относительно фронтальной

плоскости по осям X и Y.

Последнее, что необходимо знать

при работе с трёхмерными деталями,

это настройки отображения и цвет

примитивов в режиме 3D. Эти наст�

ройки устанавливаются в окне View
Configuration, которое вызывается на�

жатием клавиши L. В появившемся
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Рис. 6. Панель PCB в режиме работы

с 3D�моделями

Рис. 7. Настройки отображения примитивов в режиме 3D

Рис. 5. Сопряжённость компонентов

с деталями сборки



окне (см. рис. 7) можно выбрать один

из готовых вариантов отображения

платы в режиме 3D, приближенный к

реальному виду. Также можно устано�

вить прозрачность для Core – под�

ложки платы, Top (Bottom) Silkscreen –

шелкографии на верхнем (нижнем)

слое платы, Top (Bottom) Solder Mask –

защитной маски на верхнем (ниж�

нем) слое.

После установки ссылки на мо�

дель STEP, разработчик может вести

работу с платой и с моделью в

MCAD по отдельности. Для внесе�

ния изменений из Altium Designer в

сборку модели, необходимо выпол�

нять сохранение платы в формате

STEP 214 (стандартной командой

File Save As). Если изменения были

сделаны в исходной модели STEP,

то при запуске Altium Designer будет

предложено выполнить обновле�

ние модели и в редакторе плат.

Однако стоит помнить, что Altium
Designer проверяет обновление

только тех моделей, которые нахо�

дятся в папке, на которую имеется

ссылка в настройках DXP > Prefe�
rences > PCB Editor > Models.

Использование трёхмерных моде�

лей для отображения корпусов ком�

понентов является более востребо�

ванным. На примере резистора рас�

смотрим подход к формированию

библиотечного элемента, содержа�

щего трёхмерную модель.

В программе Altium Designer имеет�

ся возможность создания библиоте�

ки трёхмерных моделей *.PCB3Dlib,

однако следует отметить, что такие

библиотеки унаследованы из ран�

них версий программы. Сейчас мо�

дель компонента, ранее созданную в

любой из САПР твердотельного

моделирования и сохранённую в

формате STEP, можно добавить к по�

садочному месту напрямую. Рас�

смотрим данную возможность на

примере резистора.

После создания посадочного мес�

та для резистора к нему можно доба�

вить трёхмерную модель, которая на

плате будет закреплена за посадоч�

ным местом. Для этого в библиотеке

посадочных мест выполним коман�

ду Place > 3D Body. В появившемся

окне выберем тип модели Generic
STEP Model и нажмём появившуюся

кнопку Embed STEP Model. Нам пред�

ложат указать файл модели резисто�

ра в формате STEP. После нажатия

кнопки ОК к курсору будет привязан

розовый контур с заливкой в виде

сетки (если работа ведётся в 2D�ре�

жиме), который представляет собой

проекцию модели на плату. Размес�

тим этот контур в произвольном

месте, после чего откажемся от раз�

мещения следующей модели нажа�

тием кнопки Cancel.
Совместим установленную модель

(отображаемую пока в виде проек�

ции) с посадочным местом, что удоб�

нее сделать в режиме трёхмерного

просмотра (нажимаем клавишу 3).

При включении режима 3D на экране

появится модель резистора (см. рис. 8);

если этого не произошло, значит,

либо отключен просмотр моделей,

либо компонент расположен за пре�

делами видимой области. Нажимаем

последовательно клавиши V > F

(масштабировать объекты во весь эк�

ран) и клавишу L для отображения

настроек просмотра. Включаем отоб�

ражение моделей в группе 3D Bodies
(см. рис. 1).

Теперь необходимо выполнить

несколько операций по привязке мо�

дели и посадочного места. В нашем

случае достаточно совместить выво�

ды резистора с контактными площад�

ками. В общем случае может потребо�

ваться сложный набор действий по

привязке модели; это зависит от того,

как была создана модель в MCAD. Ре�

комендуется при формировании мо�

дели в исходной САПР базировать

первый вывод модели в начале коор�

динат и ориентировать модель отно�

сительно плоскости XY (предпола�

гая, что эта плоскость соответствует

плате).

Для выравнивания модели относи�

тельно платы или заданной графики

используется группа команд Tools >
3D Body Placement (доступны только

в трёхмерном режиме). Вращение

изображения осуществляется ПКМ с

нажатой кнопкой Shift. Развернём

компонент обратной стороной и вы�

полним команду Tools > 3D Body
Placement > Position 3D Body, позволя�

ющую совместить модель и графику

по одной точке. После запуска коман�

ды курсор принимает вид маленько�

го крестика, которым необходимо

выбрать модель резистора. После

этого курсор принимает вид большо�

го креста (голубого цвета), который

двигается по невидимым узлам моде�

ли. Выберем этим курсором центр

первого вывода резистора (слева на

рисунке 9), после чего курсор стано�

вится синим прицелом. Перемещаем

курсор в центр первой контактной

площадки; изменение его цвета на зе�

лёный (справа на рисунке 9) говорит

о попадании в привязку (Electrical
Grid). Фиксируем положение резис�

тора. Теперь резистор совмещён с по�

садочным местом (см. рис. 10).

Особенности работы с механичес�

кими деталями подробно рассмотре�

ны в документе TU0132 Integrating
MCAD Objects and PCB Designs.pdf, по�

ставляемом в пакете Altium Designer.

На момент написания статьи, опи�

сывающей версию программы Winter

09 (Build8.0.0.15895), фирма Altium

объявила о выходе пакета обновле�

ний Service Pack 1 для данной версии

программы, содержащем более 200

исправлений программного кода.

В следующей статье будут рассмот�

рены средства глобального редакти�

рования в Altium Designer с помощью

панелей Inspector, List, Filter, Find
Similar Objects на конкретных приме�

рах для различных редакторов (биб�

лиотек, схем, плат).
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Рис. 8. Модель резистора в режиме 3D

Рис. 9. Совмещение модели резистора

и посадочного места

Рис. 10. Готовая модель резистора


